Обработка фотографии                                                                                                                                                                    Готовим и сортируем фото 

Для начала вам необходимо «скинуть» снимки с фотоаппарата на компьютер в отдельную папку. В качестве полезного совета могу сказать, что эту папку удобней назвать, например, «25_03_2009». Как вы догадались, это дата, когда вы «скинули» материал.
Естественно, что среди множества файлов будут те, которые и не нуждаются в обработке. Поэтому в этой папке создайте подпапку, например, «Готовые». Отсмотрите весь материал и переместите хорошие, т.е. не нуждающиеся на ваш взгляд в постобработке файлы в эту подпапку. Оставшиеся будем понемногу редактировать.
Обработку фотографий МирСоветов будет проводить в небезызвестном и, пожалуй, наиболее распространенном растровом редакторе графики – Adobe Photoshop (Адоб Фотошоп), а в данном случае – Adobe Photoshop CS3. Сразу оговорюсь, что для наших целей подойдет абсолютно любая версия программы, а также и другие редакторы в зависимости от ваших желаний. Также можно пользоваться любыми другими растровыми редакторами графики, бесплатными (GIMP, Krita) и платными (Corel Photo-Paint, Microsoft Photo Editor и др). Для простейшей обработки годятся, например, ACDSee и Microsoft Paint, которые являются платным ПО. Единственное, что плата за последний взимается при покупке ОС Windows.
Итак, вы открыли подлежащий редактированию файл. 


А что же дальше? 

Формат кадра

Начинаем с определения цели. В каком плане? Сразу надо определиться, что вы планируете делать с каждым конкретным кадром – смотреть его периодически на ПК или печатать на бумаге. Если вы грезите о последнем, то тут надо отнестись более вдумчиво.
И первая потенциальная проблема – несовпадение форматов кадра. Как вы помните из статьи «Как выбрать цифровой фотоаппарат», есть аппараты, создающие кадр с соотношением сторон 4:3, а это на сегодня все «мыльницы» и, как правило, большинство аппаратов «Olympus», а есть соотношение 3:2 – такой кадр свойственен «большим» камерам. Если у вас кадры 3:2, то вам переживать не стоит и ничего не придется подгонять или учитывать. Хуже обстоит дело с форматом 4:3. Почему? А дело в том, что на бумаге печатается «классический» формат 3:2. Вспомните, например, формат 10*15. Стоп! Это все хорошо, но вы же еще не в курсе, как узнать какой формат у ваших кадров. Не переживайте, всё просто! На любом файле с вашего аппарата щелкаем правой клавишей мыши и выбираем строку «Свойства», затем, в появившемся окне – «Сводка > Дополнительно >>». 
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В самом верху видим «Ширина» и «Высота» в точках, что одно и тоже, что в пикселях. Если большее число разделить на меньшее, то вы узнаете пропорцию кадра. Например, 3072/2304=1,33.
Если вы получили 1,5, то это кадр 3:2, т.е. длинная сторона в 1,5 раза длинней короткой. Например, Х*1,5=Y пикс или 10*1,5=15 см. Если же вы получили число 1,33, то сей кадр с соотношением 4:3. Всё просто – 3:2=1,5, а 4:3=1,33.
Если печать не планируется, то ничего трогать здесь вам не потребуется. А вот в обратном случае вам придется поколдовать. Впрочем, оставим бубен и прочую атрибутику в покое, мы обойдемся без нее. Я вам даже больше скажу, мы в этом плане вообще ничего предпринимать не будем. Как? А как же несовпадение формата? А вот так! Оставим всё как есть. Не следует выполнять работу самим, за которую берут с вас деньги в фотолабораториях. Хоть это нигде и не указано, но подгонка формата включена в стоимость каждого печатаемого кадра. Даже больше, они подгоняют все кадры, если этого не сделали вы. Например, файл с разрешением в 10 Мпикс имеет размер 3888*2592 пикс, что эквивалентно размеру на бумаге 137,16*91,44 см. А вам, скажем, требуется всего лишь 15*10 см. Что делать? Размер-то, выходит, не подходит! Нужно тоже подгонять.
Однако, суть надо всё же знать. Дело в том, что кадр с соотношением сторон 4:3 не удастся привести к формату 3:2, т.к. исказится его геометрия. Вот так, например, выглядит круг. 
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Тут под требуемый формат бумаги подбирается одна сторона – и это длинная сторона. Почему? Мы помним, что длинная сторона в 1,33 раза больше короткой, тогда как в формате 3:2 – в 1,5 раза. Т.о., при подгонке формата по короткой стороне, по краям длинной стороны образуются белые поля. Например, для формата 10*15 эти поля будут примерно по 10...12 мм с каждой стороны. Конечно, если вам не лень, то вы можете, вооружившись ножницами, обрезать эти поля, но это хлопотно. Можно и оставить, но будет некрасиво. Ещё учтите, что фоторамки идут тоже 3:2.
Чтобы вам напечатали с такими полями, МирСоветов советует предупредить об этом в фотолаборатории, т.к. они печатают по длинной стороне. В этом случае белые поля отсутствуют, и фото выглядит обычным образом, но это только на первый взгляд. Здесь подвергаются «подрезке» верх и низ. А это грозит тем, что можно получить эффект «всадника без головы». Конечно, в лабораториях стараются сделать так, чтобы в этом случае больше подрезать низ кадра (где ноги), но не всегда это получается, например, если портрет сделать очень крупно, либо он групповой.
Помнить надо одно – при печати с формата 4:3 по длинной стороне подрезание кадра снизу и сверху неизбежно. Учитывайте это при съемке! Также следует отметить, что подрезание краев есть и при печати с формата 3:2, но оно пропорциональное и куда меньше (всего несколько миллиметров).
Вот посмотрите, как происходит подрезка изображения. На рисунке представлен исходный формат 4:3.
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А вот так это выглядит после подгонки.
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Как видите, достаточно сильно подрезалось снизу (указано стрелкой) и немного подрезалась правая сторона. 

Обработка фотографий в Photoshop

Не всегда получается у фотоаппарата, особенно у простого, сделать качественный, в плане техники исполнения снимок. Он может получиться с недодержкой, либо, наоборот, с передержкой, в неправильных цветовых тонах и т.д. Чтобы хоть как-то исправить эти недочеты, мы и обратимся к редактору графических файлов Photoshop.
Коррекция цвета, яркости и контраста. И начнем обработку с выбора функции «Автоматическая тоновая коррекция» («Auto Levels») в меню «Изображение > Коррекция» («Image > Adjustments»), либо сочетание клавиш «Shift+Ctrl+L». Эта функция должна одним махом избавить кадр от проблем с яркостью, контрастностью и цветопередачей, а вас – от лишних манипуляций. Т.е. все эти параметры разом должны придти в норму, но это норма только на «взгляд» программы. После этой обработки посмотрите, нравится ли вам результат. Если нет, то жмем «Редактирование > Отменить» («Edit > Undo» или «CTRL+Z»).
Функциями автонастроек можно воспользоваться и по отдельности. 
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Помимо этого можно и вручную настраивать эти параметры, зайдя в соответствующие меню и подвигая ползунки. 
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Какие установить параметры – это дело вкуса. Попробуйте множество вариантов. Учитывайте, что параметры яркости и контрастности зависимы друг от друга, поэтому, изменив яркость, вам, скорее всего, придется менять и контрастность. После получения подходящего по свету и цвету кадра переходим к глазам, если, конечно, это портрет.
Эффект «красных глаз». А какие бывают глаза? Они бывают большие и маленькие, серые, голубые, карие... Но нас интересуют здесь красные глаза. И, вернее сказать, не глаза, а зрачки.
Эффект «красных глаз» весьма неприятен, точнее – не эстетичен. Возникает он из-за отражения света вспышки от глазного дна. Происходит это, когда зрачок расширен, т.е. преимущественно в темноте (когда темно).
А избавиться от него на уже готовом снимке (файле) можно двумя способами. Как это делает функция большинства редакторов – наложением цветового пятна-растра. Или во втором варианте – более тщательной обработкой. 
В первом случае краснота зрачков «замыливается» цветовым пятном. В результате эффект «красных глаз» пропадает. Ура! Но не спешите радоваться, вместе с ним пропадает блеск в глазах, они становятся плоскими и тусклыми.
МирСоветов предлагает более трудоемкий, но качественный подход – редактировать попиксельно. С помощью инструмента «Масштаб» («Zoom Tool») или клавиша «Z» увеличиваем зрачки по очереди до максимума. Вот так выглядит красный глаз.
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При этом зрачок становится очень крупным, что позволяет редактировать каждый его пиксель. Выбираем инструмент «Карандаш» («Pencil Tool»), ставим его толщину на минимум (1 пикс). Затем, нажав «Alt», что приводит к временной смене инструмента на время удерживания клавиши, на «Пипетку» («Eyedropper Tool»). Определяем ею цвет на черном участке зрачка. А затем, отпустив клавишу «Alt», начинаем играть в мозаику, т.е. красные квадратики-пиксели заменять на черные. Но тут не следует заменять одним цветом все красные пиксели. Более красные пиксели заменяем более темным цветом, а чем они были розовее, тем более светлым (серым) надо заменять. И ни в коем случае не трогайте белый цвет – это блик от вспышки. А если он тоже не белый, то заменяйте его белым. Опять-таки не заменяйте одним цветом все 100% пятна – это будет выглядеть плоско. Надо, чтобы было чередование пикселей. Для проверки результата, периодически отодвигайте лицо лупой и посмотрите, как выглядит ваше творчество. Вот как выглядит зрачок после редактирования. 
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А вот и результат – сравните глаза. 
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Устраивает? Тогда переходим к следующему пункту.
Хотя нет. Попутно, по аналогии с коррекцией красных глаз можно, при желании, исправить некоторые дефекты, например, пятна на коже. Для чего также приближаем пятно, определяем пипеткой цвет по соседнему участку кожи и заполняем дефект. Помните – цвет заполнения надо чередовать, чтобы не получить пятна.
Почему не удается всё заполнить одним цветом и выбрав карандашик потолще? Это ведь проще и куда быстрее! Да, но и качество будет тяп-ляп. А дело обстоит так. Человеческое тело объемное и имеет рельеф. И на каждом участке создается своя освещенность, т.е. светотень. А это приводит к разности цветов.
Кадрирование и ретуширование. Хуже дела обстоят с другим. Если вы при съемке оказались невнимательны, или не было другого выхода, и в кадр попал неприглядный предмет, например, урна, то печатать такую «красоту» весьма не эстетично. А что же делать? Тут, в основном, два пути: либо выполнить кадрирование, либо заретушировать неугодный предмет.
Процедура кадрирования весьма полезна и может применяться всегда, когда необходимо выделить основной объект съемки и отбросить лишнее. Но кадрирование, как правило, не поможет, если неудачный предмет оказался очень близко к объекту съемки. Тогда придется ретушировать. А что это значит? А вот что! Тут придется проявить ваш художественный талант и побыть немного настоящим художником.
Для начала оцените тональность нехорошего предмета и его окружения. Далее его можно просто зарисовать, выбрав цвет, близкий к цвету фона, окружающего этот предмет. Это делается для того, чтобы такая зарисовка не бросалась в глаза. Можно использовать и заливку. После применения инструмента не помешает проверить результат. Не нравится – делаем отмену и пробуем другой инструмент или другой цвет.
А вот с отменой у многих может возникнуть проблема. Если вы хотите отменить только одну операцию, то всё просто – «Ctrl+Z». Хуже, если вы наваяли уже много, а после вам не понравился общий результат. Тогда указанная опция «Отменить» («Undo») уже не поможет. Необходимо воспользоваться меню «История» («History»), которое находится на главном окне. 
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В более старых версиях Photoshop’а это окно находится внизу и справа.
Затем выбираем строку, до которой надо произвести «откат». Все последующие операции (ниже выбранной строки) будут отменены.
Совсем необязательно придерживаться четких границ ретушируемого предмета. Ничего страшного, если вы вылезете на фон. А при наличии более богатого художественного опыта, можно что-нибудь подрисовать. Например, урну можно и оставить в покое, но сделать ее смешной.
А как же собственно кадрировать, спросите вы? Выбираете инструмент «Прямоугольная область» («Rectangular Marquee Tool»). Кстати, можно воспользоваться горячей клавишей «М» (латинская буква на клавиатуре или если русская – «Ь»), причем текущая раскладка клавиатуры не влияет на выбор инструмента. По аналогии можно использовать и другие горячие клавиши, если определить их по всплывающим подсказкам – это очень удобный и оперативный способ смены инструментов.
Итак, после выбора инструмента, заключаем нужное вам поле в рамку. 
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Если вы немного ошиблись, то на поле изображения нажимаем правую кнопку хвостатого устройства, то бишь мыши, и выбираем пункт «Трансформировать выделенную область» («Transform Selection»). За появившиеся маркеры корректируем область, после окончания нажимаем «Enter». При этом надо постараться, чтобы стороны были в отношении, близком к 3:2. Для этого можно воспользоваться инструментом «Линейка» («Scale») в меню «Анализ» («Analysis»).
После того, как вы откадрировали и утвердили свой выбор, заходим в «Редактирование» («Edit») , затем «Вырезать» («Cut»), либо просто – «Ctrl+X». Затем «Файл > Новый > Да» («File > New > OK»), а также можно воспользоваться сочетанием «Ctrl+N». В новом окне жмем «Ctrl+V», что означает – «Вклеить» («Paste»).
Получилось? Тогда я вас поздравляю! Вы стали уже практически профессионалами в манипуляциях с инструментами и меню. Это мы рассмотрели длинный и муторный путь. Есть куда более короткий и простой. Им вам и советую пользоваться всегда. Есть такой инструмент – «Рамка» («Crop Tool»), вот он-то и производит кадрирование по выбранному полю. Выделяем нужное вам пространство и, если вы с ним согласны, то жмем на «Enter». Если нет, то таскаем за движки в нужную сторону.
Полученный результат можно либо сохранять в папку «Готовые» для последующей печати, либо продолжить обработку. А что тут еще можно сделать? 

Дополнительные эффекты

Можно создавать всевозможные эффекты, зайдя в меню «Фильтр» («Filter»). О них и поговорим.
А что же мы будем с помощью этого меню фильтровать? Нет, отфильтровать воду мы не сможем, поэтому ограничимся лишь фильтрацией изображения на фотографии. Проще говоря, под фильтрацией следует понимать создание того или иного эффекта. Функция эта необходима для творческой обработки фотографий. Чтобы понять, как мы можем разукрасить фото с помощью фильтров, рассмотрим вкратце несколько примеров.
Все эффекты разделены на группы. Нам интересны вот эти группы.
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Группа «Имитация» («Artistic») и предназначена собственно для имитации тех или иных поверхностей или структур. Например, вот так выглядит эффект «Целлофановая упаковка» («Plastic Wrap»).
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Как вы увидели, выбрав эффект, открылось большое окно, где есть доступ ко всем эффектам, которые вы наблюдали чуть ранее в меню «Фильтр» («Filter»).
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Исходя из полученных сведений, можно смело пользоваться этим окном для подбора эффектов. Благо результат там сразу виден. Слева область предварительного просмотра, где сразу и отображается получаемое изображение. Посередине – меню эффектов. Завершает правая часть, где находятся кнопочки «Да» («OK»), т.е. применить эффект и закрыть окно, а также «Отмена» («Cancel») – закрыть окно без применения эффекта. А кнопочка «Отмена» («Cancel») способна творить чудеса перевоплощения! Нажмите и удерживайте клавишу «Alt» и вот уже кнопка стала не «Отмена», а «Восстановить» («Reset»), т.е. отменить эффект, но без закрытия окна. Ниже приведена строка со всеми эффектами, что называется «в кучу». Еще чуть ниже – движки настройки эффектов. Если их подвигать влево/вправо, то можно достичь разных результатов от одного эффекта.
Но, тем не менее, при всем удобстве, это большое окно не предоставляет доступ ко всем эффектам, хотя и группы перечислены там практически все. И открыть это большое окно удастся только из меню группы «Имитация» («Artistic»), «Текстура» («Texture»), «Штрихи» («Brush Strokes») и «Эскиз» («Sketch»). 
Чтобы использовать все эффекты, вам придется пользоваться меню «Фильтр». Вот так выглядят меню, открывающиеся в других фильтрах. 
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Группа «Искажение» («Distort») – как вытекает из названия, здесь вы сможете геометрически исказить изображение, например, вот так, с помощью эффекта «Скручивание» («Twirl»). 
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Группа «Оформление» (можно сказать, что название из англоязычной версии «Pixelate» (пикселизировать) более корректно отображает суть группы). По идее, здесь должны быть элементы оформления фотографии, такие, как, например, рамки. Но, тем не менее, этого на самом деле нет, а присутствует на самом деле, как верно указывает англоверсия, добавление пикселей в виде всевозможных структур, например, мозайки или кристаллов. В целом вкладка не очень функциональная.
Группа «Размытие» («Blur») или смазанность – позволяет получить эффекты, например, как при малой глубине резкости, или как при движении объекта, а также неплохой эффект радиального размытия, создающий ощущение головокружительного вращения. Для творческой обработки этот набор фильтров достаточно полезен.
Группа «Резкость» («Sharpen») обратна по смыслу предыдущей группе. С помощью этих эффектов можно добиться лучшей проработки рельефа и сделать контуры более объемными. Вот, например, как выглядит предыдущий эффект размытия до (на первом рисунке) и после (на втором) применения эффекта «Умная резкость» («Smart Sharpen»).
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С помощью группы «Рендеринг» («Render») можно создать эффекты освещения, а также подложки в виде волокон или облаков. Для обработки фото нам, скорее всего, ни волокна, ни облака не пригодятся. Куда бОльшей пользой обладают эффекты «Блик» («Lens Flare»), когда на фото вставляется светящийся шар с ореолом (что-то вроде эффекта светильника), и «Эффекты освещения» («Lighting Effects»), где можно создать искусственную подсветку, выбрав источники освещения, их количество и направленность. Если эффект «Блик» («Lens Flare») надо уметь применить «к месту», то последний эффект более применим и более привлекателен. Вот как выглядела фотография до обработки и после.
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Следующая группа «Стилизация» («Stylize») – здесь выбираются всевозможные стили. Например, «Ветер» («Wind»), где появляются за контуром изображения шлейфы, как будто на них дует ветер. 
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Интересный эффект «Соляризация» (Solarize). 
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Только вот применить его на портретах не удастся. И если быть придирчивым, то этот эффект не совсем та соляризация, которая достигалась на бумажном процессе.
Группа «Текстуры» («Texture»), естественно, предназначена для создания текстур на фото. Например, иногда бывает полезно добавить зернистости изображению, тогда вам пригодится меню «Зерно» («Grain»). 
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Из группы «Штрихи» («Brush Strokes») наиболее интересны эффекты «Акцент на краях» («Accented Edges»), который лучше прорабатывает края и четче выделяет контуры изображения, а также «Суми-э» («Sumi-e»), когда изображение выглядит вот так. 

[image: image24.jpg]



В группе «Шум» («Noise») всё предельно ясно – здесь можно добавлять те или иные шумы.
В группе «Эскиз» («Sketch») нам, скорее всего, не пригодятся многие эффекты. Разве что вы любитель авангардизма и вам подобные фото кажутся верхом совершенства.
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Их, конечно, тоже можно применить, но не на портретах. Можно получить интересный эффект от элемента «Хром» («Chrome»). 
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Этих эффектов более чем предостаточно, чтобы получить нужный результат. Тем более что эффекты могут накладываться друг на друга сколь угодно много раз, при этом образуются «гибридные» эффекты. Умение применить именно нужный и, следовательно, уместный эффект – вот основная задача. Это приходит с опытом. Чем больше вы пробуете, тем лучше начинаете ориентироваться, и тем быстрее подбирается эффект, т.е. он выбирается практически сразу нужный.
Напоследок МирСоветов раскроет еще один нюанс. Не всегда хочется применить эффект сразу на весь кадр, тогда вам поможет то или иное выделение. Это и как мы уже говорили, «Прямоугольная область» («Rectangular Marquee Tool») и «Овальная область» («Elliptical Marquee Tool»). Есть также инструменты типа «Лассо» («Lasso Tool»), когда мышью вычерчивается необходимая вам область. Есть и «Волшебная палочка» («Magic Wand Tool») и «Быстрое выделение» («Quick Separation»).
Вот практически и всё, что вам потребуется для обработки фото перед печатью. Разве что можно применить еще один эффект – отмену цвета, т.е. сделать изображение или его часть черно-белым. Для этого заходим в «Изображение > Режим > Градации серого» («Image > Mode > Grayscale») появляется окно «Удалить данные цветов?» («Discard color information?»). 
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Выбираем «Отменить». Всё – изображение черно-белое. Как подсказывает это же окно на приведенном выше скриншоте, аналогичную операции можно выполнить, если проделать: «Изображение > Коррекция > Черно-белый» («Image > Adjustments > Desaturate»). Однако разница в указанных способах все же есть. В первом случае черно-белым станет весь кадр, независимо от того есть ли выделенная область или нет. Во втором случае – при наличии выделенной области станет черно-белой только она.

Указанных приемов вполне хватит для большинства случаев простой обработки фотографий. Но, несмотря на простоту этой обработки, явных дефектов уже можно избежать и получить отпечатки куда более высокого качества, чем без таковой.
